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Notices
Copyright

The information in this manual is subject to change without notice for reasons of 
continuous product improvement.

A concerted effort has been made to provide an accurate explanation for the operation of 
this product. However, Glass Expansion assumes no responsibility for any inaccuracies 
that may occur in this document.

No part of this manual is to be reproduced, translated or transmitted, in whole or part, in 
any form or by any means without the prior written permission of Glass Expansion.

All rights are reserved.

© Copyright 2025

Manual No. INS-0289  	 Released: September 2025

Trademark Acknowledgement

IsoMist XR™ is a Trademark of Glass Expansion.

“Microsoft” and “Windows” are registered trademarks of Microsoft Corporation in the  
United States and/or other countries.

“Adobe” and “Acrobat”, and “Reader” are registered trademarks of Adobe Systems 
Incorporated in the United States and/or other countries.

“Oracle” and “Java” are registered trademarks of Oracle and/or its affiliates.

Other brand names and product names that appear in the IsoMist documentation are the 
properties and trademarks of their respective owners.

Product Record

The product label situated on the underside of the IsoMist specifies serial number and  
model details. Quote this information when you contact your supplier or Glass Expansion 
office for service.

Caution	

Any changes or modifications to this equipment not expressly approved by  
Glass Expansion may void your warranty.
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Safety Information
Warning

•	 IsoMist should only be operated by people who are competent in the operation of  
ICP equipment and have a basic level of PC competence.

•	 Use only the power adaptor supplied with the IsoMist to operate the device.

•	 Use only the cables supplied with IsoMist.

•	 Other than spray chamber connections, moisture must not enter IsoMist. 

•	 Ensure there is adequate ventilation for IsoMist to operate.

•	 Do not restrict the flow of air entering and exiting IsoMist.

•	 The IsoMist must only be operated on a flat, horizontal surface.

Flammable Samples

The laboratory must have a competent standard operating procedure for such samples.  
This procedure must be applied in full when operating IsoMist.

Warning	

Do not attempt to open or disassemble IsoMist in any way other than specified in 
the operation manual. Under no circumstance must the power adaptor used with 
IsoMist be tampered with. For service assistance contact the IsoMist supplier or 
Glass Expansion.

Regulatory Compliance

Electrical Safety
The power adapter supplied with IsoMist conforms with a number of electrical safety 
standards, including CE, UL, CUL, FCC, PSE, GS, CB, RCM, SAA, KC, ROSH, CCC, 
level VI, and REACH.

IsoMist is a 12 VDC device. Standards for electrical safety do not apply to equipment of 
this voltage type.
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Manufacturer’s Declaration Of Conformity

Europe
This equipment has been designed and tested to comply 
with the  requirements of the R&TTE Directive 1999/5/
EC Essential Requirements for Health and Safety (Article 
3.1(a)), Electromagnetic Compatibility (EMC) (Article  
3.1(b)), and Radio (Article 3.2) and are summarized in Table below. A Notified Body 
Opinion has also been issued to confirm that each product complies with the relevant 
Directives by testing a prototype against the prescribed EN (European Norm) standards.

Applied Standards and Test Reports 

United States
This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in 
a residential installation. This equipment generates uses and can radiate 
radio frequency energy and, if not installed and used in accordance with 
the instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct 
the interference by one of the following measures:

•	 Reorient or relocate the receiving antenna.
•	 Increase the separation between the equipment and receiver.
•	 Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected.

•	 Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following 
two conditions: (1) This device may not cause harmful interference, and (2) this device 
must accept any interference received, including interference that may cause undesired 
operation. This portable transmitter with its antenna complies with FCC/IC RF exposure 
limits for general population / uncontrolled exposure.

Specification Laboratory Test Report Number

EN 61010-1: 2010 AGC Shenzhen AGC05317151004ES01

EN 62479:2010 AGC Shenzhen AGC05317151004EH02

EN 301 489-1 V1.9.2 AGC Shenzhen AGC05317151004EE01

EN 301 489-17 V2.2.1 AGC Shenzhen AGC05317151004EE01

EN 300 328 V1.9.1 AGC Shenzhen AGC05317151004EE04

Notifed Body Opinion

CE 0700 Pheonex TestLab 16-212505
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If this equipment does cause radio interference (which can be determined by switching off 
the device) contact the supplier or Glass Expansion.

Applied Standards and Test Reports

Canada
This ISM device complies with Canadian ICES- 001.

Cet appareil ISM est conforme à la norme NMB-001 du Canada.

Australia and New Zealand
This equipment has been tested to demonstrate compliance in accordance 
with ACMA Radio communications “Short Range Devices” Standard and 
Information technology equipment - Radio disturbance characteristics.

Applied Standards and Test Reports

Japan
This equipment has been tested and certified with respect to 
Specified Radio Equipment in Japan.Certificate of Technical 
Regulations Conformity for Specified Radio Equipment in 
Japan by a Registered Certification Body (RCB ID: 204).

Applied Standards and Test Reports

Specification Laboratory Test Report Number

FCC Part 15 Subpart B

ANSI C63.4-2009

47 CFR, Part 2, Part 15 and CISPR PUB. 22 Cerpass Technology Corp. DEFD1608026

FCC Rules Part 15

ANSI C63.4:2014 AGC Shenzhen AGC05317151005FE07

FCC Rules Part 15.249 AGC Shenzhen AGC05317151005FE03

Specification Laboratory Test Report Number

AS/NZS CISPR 22:2009 AGC Shenzhen AGC0531715009AE01

AS/NZS 4268:2012 AGC Shenzhen AGC0531715009AE02

Specification Laboratory Test Report Number

TELEC-T401 (2011-05)

Article 2 Paragraph 1 Item 19

MIC Notice No.88 Appidex No.43 AGC Shenzhen AGC05317151003TE01

Certification
PHOENIX TESTLAB GmbH 
(RCB ID: 204) 16-212918a
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WEEE Compliance
The European Union WEEE (Waste Electrical, Electronic Equipment) 
directive requires the proper handling, disposal and financing of end-of-life 
equipment.

Glass Expansion deems the business end-users responsible for the 
disposal of unwanted Glass Expansion products. The business end user is 
obliged to deal with the product in accordance with local WEEE regulation.

Bluetooth SIG Certification
This equipment has been certified by Bluetooth SIG and the 
Qualified Design ID is 84469 and the Declaration ID is D031650. 
The Qualified Design Listing certificate can be accessed at the 
Bluetooth SIG listings website.

Taiwan (NCC)
注意！ 

依據 低功率電波輻射性電機管理辦法 

第十二條 經型式認證合格之低功率射頻電機，非經許可，公司、商號或使用者均不得擅自
變更頻

率、加大功率或變更原設計之特性或功能。

第十四條 低功率射頻電機之使用不得影響飛航安全及干擾合法通行；經發現有干擾現象
時，應立

即停用，並改善至無干擾時方得繼續使用。前項合法通信，指依電信規定作業之無線電
信。低功

率射頻電機需忍受合法通信或工業、科學以及醫療用電波輻射性電機設備之干擾。 

減少電磁波影響，請妥適使用。

South Korea (KC)
제작자 및 설치자는 해당 무선설비 가전파혼신 가능성이 있으므로 인명안전과 관련된 서비스는 할 수 
없습니다
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Before you start
Pack Contents

Congratulations on your purchase of your new IsoMist, please check to ensure your 
IsoMist pack contains the following items:

IsoMist XR Assembly

Power Adaptor

IsoMist XR USB Installation Media

Spray Chamber

Cable - USB connection (3 metre)

Bluetooth EDR 2.0 USB Adapter Kit
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IsoMist Overview
IsoMist utilizes the Peltier effect to provide electrical cooling or heating to the  
spray chamber. 

The Set Temperature is monitored and controlled internally using electronic hardware/
software. The IsoMist performance can be monitored and controlled from a lab PC via 
USB or Bluetooth® wireless technology

IsoMist side IsoMist rear

IsoMist top IsoMist underside

IsoMist Technical Specifications	

Operation and Environment

Environmental operating conditions 15-25 °C (59-89°F), 
10 – 80% relative humidity

Temperature* (programmable by user): 
Maximum Set 
Minimum Set

 
80°C  (176°F) 
-25°C  (14°F)

Default chamber temperature (Setting when dispatched) 5°C  (41°F)

Set temperature increments 1°C  (33.8°F)

Set temperature variation (Max) ± 0.1°C  (32.18°F)

Time taken to pass below 0°C (from 25°C) <15 minutes

Heating and cooling system Thermo-electric Peltier

User Interface
* Specified minimum temperature may not be obtained if ambient temperature is above 22°C  (71.6°F).
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User Interface

IsoMist Software** allows user to: > Change operational set temp  
> View historical operational data  
> View IsoMist performance indicators

Historical Data  
Continuously records operational data in the IsoMist’s 
volatile memory. Option to save to file (csv format)

Retains up to 24 hours of previous 
operational data***

I/O (Communication to PC) Bluetooth® Connection,  
Or via USB Cable

Bluetooth wireless network classification UZA 112 Class II  
Signal Range: 10 metres (35 ft)

Supplied USB cable length 3.0 metres

Electrical

IsoMist Power Input – (via power adaptor supplied) 12VDC – 7.5A (nominal)

Electrical supply:

Input voltage 
Input current (max) 
Input frequency

100 –240 VAC 
2 A 
50 – 60 Hz

Physical

IsoMist weight 1.15 kg (2.54 lb)

IsoMist size (L x W x H) 191 x 98 x 120mm 
(7.51 x 3.85 x 4.72 inch)

Case material Polypropylene

Minimum Requirements for Interface PC 

PC operating system Windows® 10 32/64-bit  
Windows® 11 

Hard disk space required 300 MB

Minimum screen resolution 1024 x 768 16 bit colour

Recommended RAM 512 MB

Bluetooth Wireless Network USB port

USB Communication USB port

Middleware JVM (Java Virtual Machine) 1.8.0+

** IsoMist software will need to be installed on your host PC

*** Data stored in IsoMist’s volatile memory – in the event of a power failure this data will be lost

IsoMist Technical Specifications Cont.
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Spray Chamber
IsoMist is supplied with its spray chamber already fitted. 

Note:

•	 The spray chamber is specifically manufactured for the IsoMist.

•	 A wide range of spray chambers are available to choose from.  
However, they can be classified into three main types:-

a)	Standard glass IsoMist spray chambers,

b)	Quartz IsoMist spray chambers, or

c)	 PFA IsoMist spray chambers.

•	 IsoMist is usually supplied as part of a kit. The IsoMist kit will contain all the necessary 
items required to adapt the IsoMist to your ICP. 

Standard IsoMist Spray Chamber
A glass Twister spray chamber encapsulated with Glass Expansion proprietary thermal 
conductive polymer. 

Quartz IsoMist Spray Chamber
Similar to the standard spray chamber, with the following changes:-

•	 Quartz spray chamber substituted for glass.

•	 MINI CSC nebulizer adaptor substituted for Helix CT fitting.

PFA IsoMist Spray Chamber
100% PFA spray chamber with Helix CT fitting.

Further advice
Review the range of spray chambers and other available options on our website:  
www.geicp.com or contact Glass Expansion (refer “Service and Support” section of this 
manual for contact details). 

Spray Chamber outlet, either: 
•	 8mm Stem (as shown), or
•	 13mm Male Ball.

Glass Expansion proprietary 
Thermal conductive polymer. 

Spray chamber drain

Nebuliser Connection: 
Glass Expansion proprietary Helix Fitting
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Getting Started
Removing/Replacing the Spray Chamber

When supplied, the IsoMist is already fitted with its spray chamber. If you wish to remove 
the spray chamber, perform the following procedure:

1.	 If in use, remove all connections to the 
IsoMist spray chamber.

Tip! Wait for chamber temperature 
to reach ambient before 
proceeding to step 2.

2.	 Unscrew & remove cover  
retaining screws.

Spray chamber can now be  
removed / replaced 

3.	 Replace cover and fasten with  
retaining screws.

Tip! Check cover is screwed  
down firmly.

4.	 Connect (push on) UniFit right angle 
connector to spray chamber drain 
(underside of IsoMist)

IsoMist is now ready for use, place 
into position and complete other 
connections.

Note

•	 If IsoMist has been in cooling mode, the spray chamber may be “iced-up”.  
Set IsoMist to standby mode or power down for about 15 minutes prior to removing  
the spray chamber.

•	 It is recommended to clean the spray chamber after use. Contact Glass Expansion  
or visit Glass Expansion website for the correct cleaning procedure.

•	 Once removed, keep the spray chamber in a sealed container in a safe place.
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IsoMist Placement
IsoMist is designed to be operated in the same (or close) position as the conventional  
ICP spray chamber.

For most ICP applications, additional components (fittings, brackets, etc.) will be required 
to integrate IsoMist with your ICP. Glass Expansion has developed a range of different 
IsoMist configurations to suit the diverse variety of ICP’s currently on the market.

Each IsoMist configuration is referred to as a kit. In most cases, this kit will be supplied 
with your IsoMist package. Each kit is supplied with an Installation Guide, which will 
detail:

•	 Kit parts list

	 Tip! Before you start, check all parts are present 

•	 IsoMist set-up procedure to connect IsoMist to your ICP

If you have any questions regarding the kit supplied, contact your IsoMist  
supplier or visit the Glass Expansion website www.geicp.com.

If you cannot find a kit specific to your need, contact Glass Expansion for 
assistance with your application.

Caution	

There should be adequate space around IsoMist to ensure good air circulation.

IsoMist must not be placed on a cushion, as this will block the ventilation  
from underneath.
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Helix Fitting – Nebulizer Connection

As supplied, the IsoMist spray chamber is fitted with a Helix CT fitting. The Helix CT is a 
consumable item that will need to be replaced overtime. To order replacement parts visit 
www.geicp.com

A B C

A.	Helix seal 
B.	Helix locking screw
C.	Nebulizer

Seal Locking ScrewAssembling the Helix CT

Push the Helix CT Seal into the Locking 
Screw until it clicks into place.

Inserting & Removing the Nebulizer

1.	 Before inserting the nebulizer, gently 
turn the Helix CT Locking Screw of the 
Helix CT fitting anti-clockwise.

2.	 Insert the nebulizer to the end of its travel in the Helix CT fitting.

3.	 Tighten the nebulizer in place and seal the spray chamber by turning the knurled knob 
of the Helix CT further clickwise by hand until the ratchet mechanism clicks. 

4.	 Check that the nebulizer is secure by 
gently pulling on the nebulizer where 
indicated on the right.

5.	 To remove the nebulizer, first lososen 
the fitting of the Helix by turning the 
Locking Screw counter-clockwise 1/2 
turn, then slide the nebulizer straight 
out. 
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Power Connection

Connect mains power cable to an appropriate (refer technical specification) AC power 
outlet. Connect the power adaptor to IsoMist . 

Caution
Use only the original power adaptor and mains power cable supplied with IsoMist.  
This will be appropriate for your local region. Contact your IsoMist supplier or 
Glass Expansion if the mains cable supplied is not appropriate. 

    Do not turn on power until all cables are connected

•	 Ensure all cable plugs are firmly pushed into their respective sockets

•	 Ensure all cables are fully un-coiled when in use.

•	 Ensure there is adequate ventilation around the power adaptor

•	 Do not operate IsoMist or power adaptor in a wet environment.

•	 If you are unsure about the electrical connection, check with your supervisor.
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Software installation

As supplied, IsoMist can function autonomously. IsoMist’s own operating software is 
installed and tested during manufacture. As dispatched, IsoMist will function at the default 
temperature setting - Refer to the technical specifications.

To monitor your IsoMist and modify its settings, you will need to install software to your  
host PC.

Software supplied with the IsoMist XR Pack
USB Installation Media is supplied with the IsoMist:

Contains Comments

IsoMist Software IsoMist application Controls client function

USB Drivers

You can communicate using either a USB cable or Bluetooth® Wireless technology 
PAN (Personal Area Network). Software for both communication modes can be 
loaded onto the PC.

Notes before installation:
1.	 Ensure all IsoMist XR devices are unplugged from USB ports.

2.	 Ensure old USB driver is uninstalled (refer to the Uninstall IsoMist XR section).

3.	 Make sure you have administrator rights.

Windows® 10 / Windows® 11

1

2

3

Exit all other programs you may have running on your PC.

Insert the IsoMist software Installation Media memory stick 
(supplied with IsoMist package) into a free USB port on your PC.

Locate and run the application specific to your Windows version on the Installation 
Media. Wait for the installer to load.

•	 For 64-bit versions of Windows, run ‘IsoMist-XR_windows-x64_4_2’

•	 For 32-bit versions of Windows, run ‘IsoMist-XR_windows-x32_4_2’
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4

5

6

If the following dialogue appears, 
click Yes.

Click Yes.

Click Next.
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7

8

9

Click Next.

When the device driver wizard 
pops up, click Next.

When the device driver install is 
complete, click ‘Finish’.
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10 The install is now complete. 
Click ‘Finish’.
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Bluetooth® Wireless Network

•	 The Bluetooth® system supplied requires Windows® 10 32/64 bit or  Windows® 11.

•	 As dispatched, IsoMist is pre-set to communicate with the dongle supplied in the 
Bluetooth USB Adaptor kit. The dongle is labelled with the IsoMist serial number to 
which it is paired. 

•	 Each IsoMist will require its own Bluetooth Dongle.

Bluetooth® EDR 2.0 wireless USB Adaptor kit 
contains a Bluetooth dongle

Using your computer’s built-in Bluetooth module

If your PC already has another internal Bluetooth module a conflict may occur. You can 
either manually pair the IsoMist with the internal Bluetooth module or disable the internal 
module before starting the Bluetooth setup.

Manually pairing the IsoMist XR with an internal Bluetooth module

Open your Bluetooth Settings, and ensure the ‘Bluetooth devices discovery’ is set to 
Advanced. Then, click on ‘More Bluetooth settings’ and ensure that ‘Allow Bluetooth 
devices to find this PC’ is enabled, to continue the pairing process.
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Disabling internal Bluetooth

Open your Device Manager, find and select your internal Bluetooth module, right-click 
and select Disable from the menu.
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IsoMist XR Bluetooth setup guide

Windows® 10 /  Windows® 11

Plug the Bluetooth dongle into a free USB port on your PC. You’ll know your 
Bluetooth device is ready when you see a Bluetooth icon appear in your 
system tray.

1

Right-click on the Bluetooth settings icon, and select ‘Open Settings’.

At the top of the Settings menu, look for ‘Connect a new device’ and click 
the ‘Add Device’ button.

2

3



IsoMist XR™ Operation Manual 23

After 1 minute or so, you should see a device appear with a       icon. The 
name will be the serial number of your IsoMist. Click this icon, and wait for the 
device to connect.

When the ‘Add a device’ window appears, click on ‘Bluetooth’.4

5
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Launch the IsoMist software from your desktop, or the Start menu. Once the 
IsoMist software is open, click the Power button to connect to the IsoMist.

The Connect button in the IsoMist software will now change to a Bluetooth 
button, to verify that the IsoMist is connected and operational via Bluetooth 
communications.

6

7
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Operation

* The time indicated is an approximate only.

Start up, Standby Mode and Power Down

Start up
Switch the power on at the power outlet.  
By default, IsoMist will begin to power-
up, the Status LED will display a range of 
colours to indicate: 

•	 White LED continuous:  
Processor start-up, 30 seconds*

•	 Yellow LED continuous: 
System start-up, 5 seconds*

•	 Green LED Flash: 
IsoMist is functioning and working to 
achieve chamber set temperature

•	 Green LED Continuous: 
IsoMist chamber is at set temp.

Standby Mode
The IsoMist can be placed in standby 
mode at any time. This will switch off the 
temperature control function (including 
internal fan). The IsoMist will still be active, 
but the set temperature will not be held,  
and the chamber temperature will move  
to ambient. 

Activate standby mode by:

•	 Push and hold down Standby button 
(refer figure above) for approximately 3 
seconds 

•	 Clicking Power icon through the 
IsoMist software.

•	 Clicking File►Power Off through the 
IsoMist software

The status LED will flash red as IsoMist 
shuts down.

Power Down
The IsoMist can be powered down at any 
time by switching off the power at the AC 
power outlet.

Standby button

Status LED
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Windows® 10 Windows® 11

Start IsoMist XR Application

With the power connected to IsoMist and the application software installed (Refer Getting 
Started), the user can monitor and change the IsoMist set temperature through the 
IsoMist software.

Start IsoMist application:

•	 For Windows ® 10, click on the Start menu ►Program List ► IsoMist-XR ►IsoMist

•	 For Windows ® 11, click on the Start menu ►All Apps ► IsoMist-XR ►IsoMist

When IsoMist software is first opened it will look like this until communication is 
established by clicking the connect button. Refer next topic “Communication”.
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Communication

USB Cable Connection
To communicate with IsoMist via USB 
cable, check you have:

1.	 Installed IsoMist software

2.	 Connected IsoMist to  
your PC using the supplied USB cable

3.	 Connected and switched on power  
to IsoMist

4.	 Click the Connect button on the  
IsoMist software screen

First three points are explored in the 
“Getting Started” section of this Manual

Bluetooth® Wireless Network
To communicate using the Bluetooth 
wireless network, check you have: 

1.	 Installed IsoMist software.

2.	 Performed all steps in the Bluetooth Set 
Up Guide.

3.	 Connected and switched on power  
to IsoMist.

4.	 Check USB is not connected (USB will 
override Bluetooth network)

5.	 Click the Connect button on the IsoMist 
software screen

If you encounter problems with communication, review “Getting Started” section.  
If necessary, refer to the diagnostic section of this manual.

Once USB connection is established, IsoMist software 
will look like this

Once the Bluetooth wireless network connection is 
established, IsoMist software will look like this

Icon indicates 
communication

Icon indicates 
communication
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Software Functions	

When communication is established you will be presented the following screen:

Click Icon to place IsoMist into 
Standby mode (Green = On)

Select either degrees Celsius or 
degrees Fahrenheit scale

Press to re-plot temp 
from current data file

IsoMist Performance 
Indicators

Actual chamber temperature Adjust Timescale Dialogue 
Box

Set Temperature Dialogue Box

Changing set temperature
•	 Using mouse, click one of the  

arrow buttons,

•	 Dialogue text will change to green

•	 Use arrows or mouse wheel to set 
desired temp

Wait a few seconds. A confirmation notice 
will then flash on screen to acknowledge 
the set temperature has been changed

Adjusting the time scale
Set the time scale by either scrolling the 
mouse wheel inside Adjust Time Scale 
area or by entering in a value. 
For example – for sixty seconds enter 60s, 
for five minutes enter 5m or for four hours 
enter 4h.

Confirmation Notice 
(Acknowledgement of Set Temp. Change)
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Switch Off At
IsoMist provides the facility to switch  
off the device at a particular time.

To do this select File►Switch Off At. 
Select your desired switch off time in the 
calendar dialogue and press OK.   

After a second or two the status indicator  
at the top right of the program will display 
the Switch Off Time as selected.  

You can cancel this by either pressing 
the Power Off button or selecting 
File►Switch Off At and pressing  
cancel in the calendar dialogue.

You can even turn off the IsoMist software 
and the device will still power down at the 
requested time.
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Graph (Data) Utilities

Clicking the Graph button (top bar IsoMist software) will present the following options:

Properties
Window to make changes to graph format.

Save data as
Window to save a data file (recorded 
IsoMist chamber temperature over time) to 
your PC. (CSV format)

Save as
Window to save the current graph image 
to your PC

Print
Window to format and print the IsoMist 
temperature plot.
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Diagnostics
Faults and Corrective Action	

The following table lists a number of actions that can be taken should you encounter  
a problem with the IsoMist. If you cannot resolve the problem after completing these 
instructions, please contact your IsoMist XR supplier or Glass Expansion.
Fault Solution

IsoMist will not complete start 
up (status LED - violet)

i.	 Check power cables are firmly connected.
ii.	 Switch IsoMist power off and then on at the power outlet.  

Repeat if necessary.
Tip: Do not connect a live power cable to IsoMist as a means to  
start-up. The best practice is to always use power outlet on/off switch.

Communication error USB  
(or Bluetooth)

For both USB and Bluetooth
i.	 Check IsoMist is powered on.
ii.	 Power down IsoMist, wait 10 seconds, then power up.
iii.	 Power down and then restart your PC
iv.	 Check the PC USB port (try using another USB device  

that you know works).
v.	 Review Operation Manual - “Getting Started”, and “Software 

Installation Guide” for IsoMist and/or Bluetooth wireless network.
For USB Connection
i.	 Remove and then reinsert USB cable - check cable is firmly 

connected at PC and IsoMist.
ii.	 Try to restart the PC
iii.	 Try a different port on the PC
iv.	 Uninstall IsoMist & USB driver, re-install after restarting the PC
v.	 Try to install on a different PC
Remove and then reinsert USB cable - check cable is firmly connected  
at PC and IsoMist.
For Bluetooth
i.	 Check USB cable is un-plugged from IsoMist.
ii.	 Try “Troubleshooting Bluetooth Settings” (over page).
iii.	 Remove then reinsert Bluetooth dongle.
iv.	 Check Bluetooth adaptor is firmly inserted into the computer USB port.

Cannot achieve  
set temperature

i.	 Check ambient temperature is below 30°C (optimal room 
temperature is 22°C).

ii.	 Check there is adequate ventilation around IsoMist.
iii.	 Check the spray chamber cover is screwed down correctly.
iv.	 Check the spray chamber for damage.

Condensation build-up inside 
spray chamber

i.	 Check drain (underside of IsoMist).
ii.	 Check all connections to spray chamber.

Intermittent USB 
Communication

Check for corrosion on the USB socket and cable contacts. If corrosion is 
present on the cable contacts, please try using a new USB cable. If corrosion 
is present on your computer’s USB socket, please try to use an alternate USB 
socket free of corrosion. Please consult with your PC manufacturer  
for further advice in regard to corrosion on your computer’s USB ports.

Excessively long time taken to 
reach set temperature below 
0°C (> 40 minutes)

Run IsoMist at a set temperature of 60°C for 24 hours to restore performance.
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Reset IsoMist XR to Default Settings	

To return IsoMist settings to default (Factory Settings) perform the following:

1.	 Power down IsoMist

2.	 Turn on power (or re-start from Standby). 

3.	 As IsoMist starts up, status LED changes to yellow (fan speed will also slow).  
Press and hold down the standby button, until LED changes to blue – Signalling that 
IsoMist has been reset to default.

4.	 Release standby button, IsoMist will now start as normal 

IsoMist can also be reset to default from the software screen:  
Options►Advanced►Factory Defaults

Click Yes Click Yes
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Adding IsoMist Bluetooth Device	

It is recommneded to add the IsoMist as a Bluetooth PAN device in Windows. Make sure 
the internal Bluetooth radio is disabled (refer to User Manual). 

1.	 Attach the provided Bluetooth dongle, find and click on Bluetooth icon in the Windows 
taskbar next to the time and date (tray icons).

2.	 Click on “Join a Personal Area Network” then click on Add a Bluetooth device.

Click Join a Personal Area Network

Click on Add a Bluetooth device
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1.	 Wait for IsoMist serial number to appear in the scan list and select the IsoMist and 
click on the next.

Click on Next

2.	 When successfully installed, close the window and use IsoMist software to connect to 
the device.

The process of scanning and installing might need to be repeated a few times until 
Windows successfully accept the device. However, this is only required to be done once 
on a new computer.
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Troubleshooting Bluetooth Settings	

In the event that you experience problems connecting to IsoMist through the Bluetooth 
wireless network, please check that the Bluetooth settings are correct as follows:

•	 Make sure the Bluetooth dongle is plugged into your PC and properly installed.

Right click the Bluetooth icon in the taskbar, and 
select Open Settings.

In the window that appears, click the  Options tab.

Make sure Allow Bluetooth devices to connect to 
this computer, is checked.

Make sure Alert me when a new Bluetooth device 
wants to connect, is checked.

Click Apply, then OK.
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Changing Bluetooth dongle used with IsoMist XR	

Although IsoMist is commissioned and dispatched with its own (paired) Bluetooth dongle 
an alternative Bluetooth system can be substituted. The following changes will need to be 
made to IsoMist.
1.	 If connected remove the previous Bluetooth dongle from your PC.

2.	 Insert the new Bluetooth dongle into your PC.

3.	 Right click the Bluetooth icon in the taskbar, and select Open Settings.

5.	 Select the Generic Bluetooth Radio,  
and click Properties.

4.	 Click the Hardware tab on the dialogue box 
that appears.
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Changing Bluetooth dongle used with IsoMist XR	

9.	 Ensure IsoMist software is connected through 
USB.

10.	 Select Options►Advanced►Set IsoMist 
Bluetooth Pairing

7.	 Connect IsoMist to your PC using USB cable supplied with IsoMist.

8.	 If not already running, start IsoMist Software and connect to IsoMist.

6.	 In the dialogue that appears, click the Advanced 
tab. Write down the device address shown.
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11.	 Enter the device address, 
found in step 6, into the 
Bluetooth transceiver 
address dialogue box.

12.	 Select Master or Slave PAN mode operation:

•	 Master (Glass Expansion Bluetooth dongle)
•	 Slave (For assistance with third party Bluetooth, please contact Glass Expansion)
13.	 Click OK.

14.	 Disconnect USB Cable then close and restart IsoMist software

15.	 IsoMist should now be able to connect to your PC. To complete the setup, follow steps 2 onward on page 22 in 
the “IsoMist XR Bluetooth setup guide” section of this manual.

Please refer to the “Bluetooth Set Up Guide” for further information on how to 
complete the Bluetooth connection to the IsoMist XR.
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Uninstall IsoMist software	

Following installation of IsoMist software onto your PC you should have the  
following programs: 

•	 Glass Expansion USB Network Device Software and;

•	 IsoMist.

If necessary, you can remove these programs using the standard Windows® procedure.  
As a guide, the following pages provide a step by step procedure.

You must have administrator rights to uninstall software from your PC.  
First, you must close any other programs you may have running and it is 
recommended you restart your PC when prompted.

How to uninstall
Detach the IsoMist XR USB cable from your PC before removing the USB driver and 
IsoMist software.

3.	 To uninstall the IsoMist application, 
search for: ‘isomist’ and look for 
‘IsoMist-XR’.

Windows® 10 Windows® 11
1.	 Click Start.

2.	 For Windows® 10: Right-click 
the Start button ► ‘Apps and 
Features’	  
 
For Windows® 11: Right-click 
the Start button ► ‘Apps and 
Programs’
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4.	 Click the ‘Uninstall’ button

•	 For Windows® 10: Click the application, then click ‘Uninstall’

•	 For Windows® 11: Click the three dots to the right on the application listing, and select ‘Uninstall’

5.	 If the following dialogue appears, click ‘Yes’

Windows® 10 Windows® 11
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6.	 Click ‘Next’

7.	 The uninstall is now complete. Click ‘Finish’.

Uninstall IsoMist software Cont.	
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Service and Support
Glass Expansion’s prime objective is to supply world-class products and prompt customer 
service. To ensure minimum downtime, should you encounter any problems with IsoMist  
or the power adaptor device, we ask you check the following points first before calling  
for assistance: 

•	 Is the mains power cable fully plugged into the AC power outlet and is the power outlet 
switched on?

•	 Is the AC power outlet functioning correctly? (Check by using another electrical device)

•	 Are all connections correct?

•	 Is there adequate ventilation around the IsoMist?

•	 Have you reviewed the Diagnostic section in this manual?

•	 Is the ICP Instrument functioning correctly?

Should none of these actions resolve the problem, contact your IsoMist supplier  
or Glass Expansion. 

INTERNATIONAL
Glass Expansion

6 Central Boulevard 

Port Melbourne 

Vic 3207, Australia

Telephone: +61 3 9320 1111 

Toll Free (Aust): 1800 777 638

Facsimile: +61 3 9320 1112 

Email: enquiries@geicp.com

AMERICAS
Glass Expansion Inc

31 Jonathan Bourne Drive

Unit 7

Pocasset, MA 02559, USA

Telephone: 508 563 1800

Toll Free (US): 800 208 0097 

Facsimile: 508 563 1802

Email: geusa@geicp.com

EUROPE
Glass Expansion GmbH

Friedenbachstrasse 9 

35781 Weilburg

Germany

Telephone: +49 6471 3778517 

Email: gegmbh@geicp.com
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Product Care

General Care	

Ensure components associated with the IsoMist are not dropped, nor have heavy objects 
dropped or stored on top of them.

If you know or suspect a heavy object or liquid has been dropped onto the IsoMist or the 
power adaptor, turn off both devices immediately and contact the IsoMist supplier  
or Glass Expansion.

Cleaning	

Before cleaning the IsoMist, it is good practice to always disconnect the power from  
the power outlet. 

Clean the IsoMist with a cloth lightly moistened with a mild detergent solution.

Do not use any type of abrasive pad, scouring powder, or solvent as these can damage  
the component surface.

Storage	

When not in use, the IsoMist can be stored away in the container in which it arrived.

Do not store IsoMist in an environment that could be subject to: 

•	 Ambient temperature above 35°C (95°F) or below 10°C (50°F)

•	 Hazardous chemicals

•	 Excessive dust

•	 High humidity

•	 Wet or moist area
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WARRANTY

Glass Expansion Warranty	
All Glass Expansion products are supplied with 
our NO-RISK GUARANTEE. If the performance 
of the product is unsatisfactory or if it is 
unsuitable in any way, we will provide a credit 
or refund, provided it is returned in original 
condition within 14  
days of receipt*.

We warrant that all of our products are free from 
defects in material and workmanship and meet 
applicable specifications. We agree to repair 
or replace, at our option, a product that, under 
proper and normal use, proves to be defective 
within 12 months of delivery. We may, at our 
option, use refurbished items that are equivalent 
to new in performance. Repaired or replaced 
products are warranted for the balance of the 
original warranty period.

This warranty does not include consumable 
items that, by their nature, may not function 
for 12 months. Such items include nebulizers, 
spray chambers, torches, tubing, valves, 
RF coils, cones, and components of these 
items. Other items made from glass, quartz or 
ceramic are also not included in the 12-month 
warranty. The consumable items listed here are 
warranted only that they are free from defects in 
material and workmanship and meet applicable 
specifications on delivery.

This warranty does not cover defects resulting 
from improper or inadequate use, installation, 
maintenance or repair. We also do not accept 
liability for consequential damage of any kind 
arising from the use of our products. It is the 
purchaser’s responsibility to ensure that our 

products will be used only by qualified persons 
who are properly trained in the appropriate 
laboratory procedures and that the products are 
safely stored, handled and used. We assume no 
liability for any injury to personnel or damage to 
equipment arising from the handling or use of 
our products.

Procedure for Product Returns
If you need to return a product, please advise us 
by email to enquiries@geicp.com and we will 
send you a Product Return Form.

If a product has been used, you will be asked 
to detail things like how long it was used for 
and what it was used for. Once we receive 
the returned product, our technicians test and 
evaluate the product and we then advise you 
the outcome of the evaluation and whether a 
product exchange or refund can be issued. For 
account customers, refunds are given in the 
way of credit notes applied to the customer’s 
original invoice/account. If a product exchange 
is issued, we provide a credit note for the 
product returned and invoice the customer for 
the new product.

For health and safety precautions, all 
products returned to Glass Expansion must 
be free from any hazardous contaminants. 
Please ensure that all products are properly 
cleaned and safe for handling before 
returning to us. 

Glass Expansion reserves the right to refuse 
acceptance and/or inspection of any returned 
products which show visible signs of 
hazardous contaminants.

* This does not apply to nebulizers without EzyLok and spray chambers without Helix. We have now standardised 
our production on nebulizers with the EzyLok argon connector and spray chambers with the Helix nebulizer 
interface, and these are what we hold in stock. We will still accept orders for nebulizers without EzyLok and 
spray chambers without Helix, but these now need to be specially made. Since they cannot be returned to stock, 
we will not accept return of these products unless they are faulty. If they are faulty, they can still be returned for 
replacement or refund.
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